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LexWiki 1.1 Users' Guide 

______________________________________________________________________________________________________ 

Introduction  
LexWiki is an open source, high-capacity editor for distributed terminology development.  Developed by Mayo Clinic with 
collaborations of National Cancer Institute (NCI), World Health Organization (WHO) and Stanford University, it is a synergistic 
effort for the development of a collaborative terminology authoring platform based on the integration of LexGrid and Semantic 
MediaWiki technologies. This version of LexWiki does not include Protégé components.  

The features of LexWiki include:  
• Browsing support  

• Hierarchy view with Category Tree extension  
• Concept-oriented view with Header tabs extension  
• Proposal browsing - all proposals listed by curation status and by categories with ontology browser 
• My Proposal browsing with MyWorkflow extension  

• Authoring support  
• The LexWiki Protégé Tab is used for loading contents into Wiki.  
• LexWiki Editor – semantic forms/Header Tabs: may propose change, new concept or concept removal  
• Change tracking and view changes  
• Proposal Commenting  
• Proposal Voting  
• Evidence attachment with citation and file upload  

 

Scope  
This document is intended for terminology content authors. It provides an overview of the browsing and authoring features that 
LexWiki supports.  
 

Prerequisites  
LexWiki is a Web-based application. You will need a web browser and the address (URL) of your LexWiki application. You will 
also need an account (username and password).  
 

Authenticating  
In order to use the authoring and workflow features of LexWiki, you will need to authenticate by clicking the login link at the top of 
the page and providing our username and password.  
 

Browsing  
This page explains ways to browse and search for terminology on the LexWiki.  
 

Browsing Concepts  
Note: Concepts are called categories on the wiki pages. For the sake of familiarity, the help pages use concept. 
The LexWiki installer automatically loads a sub set of the BiomedGT terminology. When you view a newly installed LexWiki, you 
should see the following on the main page. 
 
This is the terminology Tree View. You can drill down to more specific concepts by clicking the plus sign [+] which precedes to 
each concept. 
Note: A concept with a name proceeded by a bracketed period [.] has no child concepts. 
Once you select a concept, the wiki displays a detail page for that concept. For more information about the detail page, see 
Examining Concept Details. 
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Browsing Properties, Roles, and Associations  
From the terminology Tree View, click the name of any concept. Once you select a concept, the wiki displays a detail page for that 
concept. For more information about the detail page, see Examining Concept Details.  
 

Searching for Concepts  
Note: Concepts are called categories on the wiki pages. For the sake of familiarity, the help pages use concept. 
The most efficient way to search is to use the search box at the top of the left navigation bar. The following topics explain how to set 
your search preferences, perform a simple search, and use the Autocomplete feature. 
 

About the Go Button and Search Button  
Below the search box, you will find two buttons: Go and Search.  

 Click the Go button when you know that a category (concept) page exists and you know the exact name of the page. For 
example, if the full page name is Category:BGT  
Cytoskeletal Gene(B20918), type the full page name in the search box and click Go.  
Although this works best when you provide the exact page name, even entering an inexact name displays a results list with 
possible matches.  

 Click the Search button for general searches where you enter a search term or use Autocomplete. This displays a search 
results page.  

 

Setting Your Search Preferences  
Note: You need to be authenticated to perform this task. 
You can set search preferences to control how your results are displayed and which namespaces you use for searching. To set 
preferences, follow these steps: 
1. Log in to LexWiki.  
2. Click the my preferences link in the top right of the page.  
Your user profile page appears.  
3. Click the Search tab.  
4. Set your results display preferences by typing values in the three text boxes: Hits per page, Lines per hit, and Context per line.  
5. Select namespaces for searching by selecting the appropriate boxes.  
We recommend checking at least Category, Relation, and Property. You may also want to add Proposal and Proposal Talk.  
6. Click the Save button.  
A message confirms that your preferences have been saved.  
 

Using a Simple Search Term  
You perform a simple search when you simply enter a search term or phrase and run the search. To search using a term or phrase, 
follow these steps:  
1. Click in the search box at the top of the left navigation bar.  
2. Type a search term or phrase.  
3. Click the Search button.  
The wiki displays a Search Results page.  
4. To view details for a concept:  

• Click the concept name, or  
• Click the plus sign [+] preceding the concept name to drill down to child concepts.  
Note: A category with a name proceeded by a bracketed period [.] has no child concepts.  

Once you select a concept, the wiki displays a detail page for that concept. For more information about the detail page, see 
Examining Concept Details.  
 

About Autocomplete  
The Autocomplete feature enhances your searches by providing a list of suggested terms, based on what you type. To activate 
Autocomplete while entering search text, type some text and then press Ctrl + Spacebar (on Mac, this is Ctrl + Alt + Spacebar). 
When Autocomplete is active and working, you will see a red swirling circle while entering a search term.  
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Note: If you want to use Autocomplete without pressing Ctrl + Spacebar, you can turn on an auto-triggered setting as described in 
steps 5 and 6 of Setting Up Autocomplete.  
Autocomplete recognizes namespaces for the available terminologies on the wiki. If you type a string without a namespace prefix, 
such as bed followed by Ctrl + Spacebar, the returned list displays concepts (categories) with a BGT prefix.  
To restrict search results to a specific namespace, add the namespace prefix to your search text. For example, if you want to find a 
Semantic Type from the STY namespace such as the STY Cell concept (category), you would type the following:  

STY followed by Ctrl + Spacebar  
 
or  
 
STY Ce followed by Ctrl+ Spacebar  

 

Setting Up Autocomplete  
Note: You need to be authenticated to perform this task. 
Autocomplete is set up by default. As explained in About Autocomplete, you can use this feature by pressing Ctrl + Spacebar while 
searching. If Autocomplete doesn't appear to be working, or if you would rather not press this keystroke during search, you can 
enable the Auto-triggered auto-completion setting in step 6 of the following procedure. 
Note that you may sometimes get faster results by using a simple search. For example, if you type lung (instead of lung as part of a 
phrase), then simple search might be the better choice. 
To verify and/or change Autocomplete settings, follow these steps: 
1. Log in to LexWiki.  
2. Click the my preferences link in the top right of the page.  
Your user profile page appears.  
3. Click the Skin tab.  
4. Select the OntoLiteSkin option if it is not already selected.  
5. To enable Autocomplete without requiring a keystroke, do the following:  

1. Click the Misc tab.  
2. Check the Auto-triggered auto-completion box.  
If you select this setting, you don't need to press Ctrl + Spacebar to use Autocomplete.  
You can tell that this setting is enabled if you have not pressed the keystroke and a red swirling circle appears while you 
are entering a search term.  

6. Click the Save button.  
A message confirms that your preferences have been saved.  
 

Using Autocomplete  
To search using Autocomplete, follow these steps:  
1. Click in the search box at the top of the left navigation bar.  
2. Type one or two characters.  

• If Autocomplete is set to work automatically, you will see a red swirling circle while entering the term.  
• If you do not see the red swirling circle, press Ctrl + Spacebar. To enable automatic use of Autocomplete, you need to 
change your settings as explained in Setting Up Autocomplete.  

3. (Optional) When the drop-down results list appears, do either of the following:  
• Select a term from the list to add it to the search box; or  
• Type additional characters to change the results appearing in the list. 

Hint: All BiomedGT concepts start with the letters BGT before the name, so type something such as BGT Activ to find BGT 
Activity or other variations. 
4. Do either of the following:  

• Click the Go button when you know that a category (concept) page exists and you know the exact name of the page. For 
example, if the full page name is Category:BGT  
Cytoskeletal Gene(B20918), type the full page name in the search box and click Go.  
Although this works best when you provide the exact page name, even entering an inexact name displays a results list with 
possible matches.  
• Click the Search button for general searches where you enter a search term or use Autocomplete.  

5. Click the Search button.  
The wiki displays a Search Results page.  
6. To view details for a concept:  

• Click the concept name, or  
• Click the plus sign [+] preceding the concept name to drill down to child concepts.  
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Note: A category with a name proceeded by a bracketed period [.] has no child concepts.  
If the list did not appear in step 4, check your Autocomplete settings. 
Once you select a concept, the wiki displays a detail page for that concept. For more information about the detail page, see 
Examining Concept Details. 
 

Examining Concept Details  
When you select a concept from a search results list, the wiki displays a detail page for that concept. The page name has the concept 
name and code (for example, Category: BGT Beckers Nevus(B4097) or Category:CTCAE Allergy/Immunology) and includes links to 
other concepts.  
Note: If the page name includes v1 in the title, a collaborator has submitted a proposal to modify the represented concept in some 
way. If this is the case, concept details that are affected by the proposal are shown in red, bold text.  
 
Each detail page includes the information described in the following table.  
 
Page Section What it Shows 
Lexical Displays the concept code, preferred name, links for the coding scheme and coding scheme version, 

synonyms, and URI. 
Properties Displays the META CUI and relevant properties. 
Associations Displays associations for the selected concept. You can click association links to view more information 

about each one. 
FactBox Summarizes the selected concept, with links to more detailed information. Use the following methods to 

view specific information:  
• Click a property to link to a descriptive property page.  
• Click an association (relationship) to link to a descriptive page for the related concept.  
• Click the spyglass icon on the right of each property/association to search for concepts that have the same 
association. For example, clicking the icon to the right of BGT Disease Has Associated Anatomic Site BGT 
Integumentary System returns a list of all other concepts that have the associated anatomic site BGT 
Integumentary System.  
• Click the RDF Feed link in the upper right area of the FactBox to view the details for the concept in 
XML/RDF format. To learn more about RDF, see the W3C RDF specification [1]. 

 

Authoring  
This page explains how to submit proposals and participate in discussions. It also provides links to pages that provide help with 
editing.  
 

Before You Begin  
Before you can author content, you will need to authenticate.  
 

About the Edit Toolbar  
When writing and editing wiki pages, note the following points about the Edit toolbar:  
• The toolbar includes icons for bold and italic.  
• The toolbar includes a carriage return symbol for creating a line break in the middle of a paragraph.  
• The toolbar does not include a button for adding bulleted lists. When you need a bulleted list item, type an asterisk (*) at the 
beginning of a line of text.  
• The toolbar includes a signature icon labeled "Your signature with timestamp." Click the icon to append your user name and add a 
date/time stamp to your comment.  
Note: The check box at the bottom of the text entry box enables you to switch between a syntax-highlighted and standard editor. If 
your signature is pre-pending rather than appending, make sure that this box is not checked.  
A complete description of the Edit toolbar is available at http://meta.wikimedia.org/wiki/Help:Edit_toolbar.  
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Proposing Changes and Additions to Terminology  
If you are authenticated, you can propose changes or additions to the terminology that LexWiki is hosting. For example, you might 
suggest changes to such information as preferred names, definitions, synonyms, associations, and parents. You can do this through 
either a structured or unstructured proposal.  
 

About Structured Proposals  
The more formal method of proposing changes and additions is through the submission of a structured proposal. This type of 
proposal requires that you complete a standardized submission form. You can save and edit the proposal using the same structured 
form. For more information, see Submitting a Structured Proposal.  
 

About Unstructured Proposals  
Before proposing changes, a group of collaborators can start a discussion about the nature of the changes using a discussion page. 
They can also use this page to make recommendations to curators who may be integrating content from another terminology. A 
discussion page enables each contributor to add signed, date-stamped comments.  
Examples of discussion page content:  
• "You should consider creating the sibling concepts for this concept because we need them in order to..."  
• "We recommend adding a new property X for this concept and all its children to represent Y (give definition and other relevant 
info)."  
Note: Be as specific as possible in your unstructured comments and recommendations.  
 

Creating a Structured Proposal  
Prerequisite topic: About Structured Proposals  
To submit a structured proposal, follow these steps:  
1. Find the concept for which you want to submit a proposal.  
2. Select the concept in the search results list.  
The wiki displays the detail page for the concept.  
3. Ensure that the second tab at the top of the page shows propose changes in red letters and not proposed changes in blue letters.  
If the tab shows proposed changes in blue letters, then someone has already submitted a proposal for this concept.  
4. Click the propose changes tab at the top of the page.  
The LexWiki BGT Form page appears. The tab at the top of the page shows the word special. Note the four tabs: Meta, Lexical, 
Properties, and Associations.  
5. Complete the fields for each tab using the Structured Proposal Form Reference section.  
See Also: Submitting Proposals 
 

Creating an Unstructured Proposal  
Prerequisite topic: About Unstructured Proposals 
To add or contribute to a proposal discussion, follow these steps: 
1. Browse or search for the term that you want to discuss.  
2. Click the discuss tab at the top of the category page for the selected term.  
If a discussion is already in progress, you will see previously entered comments on the discussion page. If no one has added 
comments, you will immediately see the page title, the Edit toolbar, and a box for typing text. Regardless, you can use the toolbar 
and text entry box to add your own comments.  
3. Write and edit your comments in the text entry box:  

• Start each bulleted item with an asterisk (*).  
• Surround subheadings with equal signs (=== heading ===)  
• Use the Edit toolbar to add formatting.  
For a complete description of the toolbar buttons, see the following MediaWiki page:  
http://meta.wikimedia.org/wiki/Help:Edit_toolbar 

4. Append your signature to the comments by clicking the Your signature with timestamp button.  
5. Click Save page.  
The most recent comments appear at the top of the page.  
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Submitting Proposals  
Prerequisite topics:  
• Creating a Structured Proposal  
• Creating an Unstructured Proposal  
When you are ready to submit a proposal for consideration, you can submit it as a package.  
The package can contain only one proposal or several proposals. Once you have submitted a proposal package, your package enters 
into a workflow process. The process has various stages, each with a status designation that identifies what process stage the package 
has reached:  
• New  
• Ready to Submit  
• Submitted  
• In Process  
• Completed  
 

Creating a Workflow Package  
Prerequisite topic: Submitting Proposals 
If you are a registered user, you may click “My workflow” at the top of the page where you may browse and define “MyWorkflow” 
and browse “My Proposals”. Collaborators can propose changes to an existing concepts or propose new child concepts. A logical 
grouping of the various proposals from a particular collaborator forms part of his/her workflow package. This can be submitted for 
curation en masse for curation to be incorporated into the existing ontological model. The status for the individual packages tracks 
the changes to the workflow status. The user can log in to Lexwiki at any point of time and be informed of the status of the workflow 
by clicking on the “My workflow” link at the top of the page. 
Post-curation, the workflow status can be set to one of Completed or Completed w/issues. 
The individual proposals can then be browsed to check whether they were accepted or rejected. For proposals that are accepted the 
wiki concept is updated [or created] accordingly. 
To create a workflow package, follow these steps: 
1. Click on the "My workflow" tab at the top of the page.  
2. In the My Workflow Packages section, enter a name for the workflow package and click the Define Workflow Package button.  
The Add Workflow Request: Workflow:{Package Name} opens.  
3. Select a Priority option.  
4. Add a comment or instructions in the text entry box.  
5. Follow these steps in both the Structured Proposals and Unstructured Proposals sections:  

1. Click Add another.  
2. Enter the proposal name in the Proposal field.  
3. Repeat steps a and b to add more proposals.  

6. Click Save page.  
The WorkFlow:{Package Name} page updates to show details about the package that you just submitted. This page 
includes the following information:  
• Submitter: Your user name  
• Submission date: The submission date in numerical format  
• Priority: The priority level that you assigned  
• Proposal: Concepts included in the package  
• Package status: The current workflow status for the package  
• Facts about {Package Name}: A FactBox showing the workflow component, submission date, priority, and submitted 
name. The FactBox also provides a link to the RDF feed for the package.  
• Categories: Shows the current status of the package. The initial status is WorkFlow Pending Receipt.  

 

Structured Proposal Form Reference  
This page explains the fields used on each of the structured proposal form tabs.  

Before You Begin: Understanding Common Features  

 
Each of the tabs on the structured proposal form includes the features described in the following table.  
Feature Description 
Watch this page Check box that marks a page so that you will receive e-mail notifications of any changes. This is 

especially useful when you are collaborating with others on a proposal.  
Note: Checking this box on any tab enables it on all tabs. 
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Save page Saves the current proposal and displays the full proposal page. To resume editing, click the Edit tab 
at the top of the page. 

Show preview Shows an unsaved preview of the page. In the proposal context, instead of clicking Save page when 
viewing a preview, click the Edit tab at the top of the page to resume editing, then save the page. 

Show changes Not recommended; not currently useful in this context. 
Cancel Discards any unsaved changes. 
 

Meta Tab  
The Reason for Change field is a text field in which you can type the reason for the requested change. The following table lists 
change types and examples.  
Type of Change Examples 
Data Correction • Typographical error  

• Incorrect or missing treeing  
• Incorrect or missing annotation  
• Incorrect or missing class property  

Content Change or  
Enhancement 

• Modification to content  
• Reorganization of content  
• Addition of content  
• Federation with additional ontology 

Feature Change or  
Enhancement 

• Usability  
• Help and user assistance  

 

Lexical Tab  
The Lexical tab displays lexical information about the selected concept. The following table describes each field.  
Field Name Description 
Concept Code Non-editable field used to display the concept code. 
Concept Category  Concept Type property used only by BiomedGT curators. Possible values are listed here for 

informational purposes only:  
• C = Common Words; these are linked to external references for definitions and usage, if 
possible.  
• N = Navigation  
• O = Ontologic  
• U = Unreviewed (or Undecided) 

Preferred Name Editable field. Remember that there can be only one preferred name. A preferred name should be 
explanatory and should help identify the context where possible (for example, Body Temperature 
rather than Temperature). 

Coding Scheme Refers to the terminology or subset in which the concept participates. The original coding scheme 
is non-editable, but you can add a second coding scheme where appropriate.  
For example, if the group working on CRCH subset wants to add another unit of measure to the 
nutrition subset that already exists in BiomedGT, they can select that unit and add CRCH as a 
coding scheme. To add a second coding scheme, click Add Another. 

Synonyms Shows previously added synonyms and enables you to add or remove synonyms. 
Definition Used to add or modify the main definition. Definitions should provide defining information and 

should not include too much extraneous information. You can add extra information either as an 
AltDefinition or Editorial Note if desired. Example of a Definition: Cell: The smallest unit of 
living structure capable of independent existence, composed of a membrane-enclosed mass of 
protoplasm and containing a nucleus or nucleoid. (Source: NCI) 

AltDefinition Used to display a definition from an alternate source. 
Editorial Note Used to provide explanatory, scope, or other information. Note: This property is published. 
Example Illustrates the concept. This is not currently published in BiomedGT but is used by curators for 

context. 
URI Non-editable field that displays the URI for the selected concept. 
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Properties Tab  
The Properties tab has only one field: Concept Property. Use this field to add any of the notation properties currently available in 
BiomedGT. 
Note: There is currently no pick list for this field. If you know which property you are looking for, do either of the following: 
• Use Autocomplete to find the property. To use Autocomplete, type part of the property name, then press Ctrl + Spacebar.  
• Use the NCI Thesaurus Browser [2] to search for the concept and view a list of currently available properties. On the results page, 
scroll down to the Information About This Concept section.  
 

Associations Tab  
The Associations tab enables you to change or add relationships. The following table describes each field on this tab.  
Field Name Description 
Parents Used to change, remove, or add a parent concept.  

Note: Having multiple parents (multiple inheritance) is discouraged in most cases. 
Associations Used to add relationships to other concepts (categories). This creates a link from one concept to another 

concept in the wiki.  
Note: If you know that a property exists, use Autocomplete to help you find the property name and value. 
To use Autocomplete, type part of the property name, then press Ctrl + Spacebar. If you are suggesting 
creation of a new property, adding a property name that does not exist will create an unresolved link, 
which you can then edit as to your intended meaning. 

 

References Tab  
The References tab enables you to add URIs to relevant Web sites, PubMed IDs, and ISBNs.  
 

External links  
[1] http://www.w3.org/RDF/  
[2] http://nciterms.nci.nih.gov  
Source: http://38.100.14.170:9999/mediawiki-1.13.3/index.php?title=LexWiki_1.1_  
Users'_Guide  
Principal Authors: Joshua.phillips  
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